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MÔN: TOÁN
1. LÍ THUYẾT
I. ĐẠI SỐ
Ôn tập toàn bộ kiến thức chương I, II theo SGK 
II. HÌNH HỌC
Ôn tập toàn bộ kiến thức chương I, chương II đến hết bài trường hợp bằng nhau thứ 2 của tam giác theo SGK 
1. BÀI TẬP
I. ĐẠI SỐ
Dạng toán tính giá trị biểu thức:


	 		 


	 	 


	 	 


	 			 


	 	 



	                
Dạng toán tìm x, y.
Tìm x, y biết:








a)  		b)  	                                                                           


i)       	                 



		        m)      	 
Dạng toán về đại lượng tỉ lệ thuận, đại lượng tỉ lệ nghịch  :
Bài 1 : Lớp 7A tổ chức nấu chè để tham gia phiên chợ quê do nhà trường tổ chức cứ 4kg đậu thì phải dùng 2,5kg đường. Hỏi phải dùng bao nhiêu kg đường để nấu chè từ 9kg đậu
Bài 2 : Để làm nước mơ người ta thường ngâm mơ theo công thức : 2kg mơ ngâm với 2,5kg đường. Hỏi cần bao nhiêu kg đường để ngâm 5kg mơ ?
Bài 3 : Biết 17 lít dầu hỏa nặng 13,6kg. Hỏi 12kg dầu hỏa có chứa được hết vào chiếc can 16 lít không ?
Bài 4 : Một ô tô đi từ A đến B hết 6 giờ. Hỏi ô tô đó đi từ A đến B hết bao nhiêu thời gian nếu nó đi với vận tốc mới bằng 1,2 lần vận tốc cũ.
Bài 5 : Ba đội máy cày, cày ba cánh đồng cùng diện tích. Đội thứ nhất cày xong trong 3 ngày, đội thứ hài trong 5 ngày và đội thứ ba trong 6 ngày. Hỏi mỗi đội có bao nhiêu máy ? Biết rằng đội thứ hai có nhiều hơn đội thứ ba 1 máy (năng suất các máy như nhau).
Bài 6 : Biết 15 công nhân làm một đoạn đường trong 6 ngày. Hỏi 20 công nhân làm đoạn đường đó trong bao nhiêu ngày ? (Giả sử năng suất làm việc của mỗi công nhân là như nhau)
 Dạng toán hàm số và đồ thị :

Bài 1 : Cho hàm số y = a.x (a 0) có đồ thị là đường thẳng d.
1. Xác định hệ số a biết d đi qua A(- 1; -2)
1. Điểm nào trong các điểm sau thuộc d ?
M(2; - 3)	A(1; - 2)	I(- 2; 4)
Bài 2: a) Vẽ đồ thị hàm số y = - 0,25.x
	 b) Điểm nào sau đây thuộc đồ thị hàm số trên : H(2; - 0,5)	K(- 4; - 1)
Bài 3: Vẽ trên cùng một hệ trục toạ độ đồ thị các hàm số sau :


	a) y = - x       	b)  	          c) 
Bài 4:  Cho hàm số y = -3x
1. Vẽ đồ thị hàm số
1. Điểm nào sau đây thuộc đồ thị của hàm số y = -3x : B(-1 ; -3) và
 C(0,5 ; -1,5)
Dạng toán tìm GTLN, GTNN:
Bài 1: Tìm giá trị lớn nhất của biểu thức sau: 

      A =                             

      B = 

                 M =                      

                 N =  
Bài 2: Tìm giá trị nhỏ nhất của các biểu thức sau:

   A =                        

   B =       

  M =  

  N = 
II. Hình học:
Bài 1: Cho Ot là tia phân giác của góc nhọn xOy. Trên tia Ox lấy điểm A, trên tia Oy lấy điểm B sao cho OA = OB. Trên tia Ot lấy điểm M sao cho OM > OA.
1. 
Chứng minh .
1. Gọi H là giao điểm của AB và OM. Chứng minh OH vuông góc với AB.
1. Vẽ đường thẳng d vuông góc với AB tại A. Chứng minh: d // Ot.
Bài 2: Cho tam giác ABC vuông tại A. Gọi M là trung điểm của AC, trên tia đối của tia MB lấy điểm D sao cho MD = MB.
1. Chứng minh : AD = BC.
1. Chứng minh : AD//BC
1. Chứng minh : CD vuông góc với AC.
Bài 3: Cho tam giác ABC (AB < AC). Trên tia BA lấy điểm D sao cho BD = BC. Nối C với D. Tia phân giác của góc ABC cắt cạnh AC tại E, tia phân giác của góc DBC cắt cạnh CD ở I.
1. 
Chứng minh 
     b) Chứng minh BE vuông góc với BI.
c)  Kẻ AH vuông góc với CD tại điểm H, chứng minh AH // BI.
Bài 4: Cho hai đoạn thẳng AB, CD cắt nhau tại trung điểm O của mỗi đoạn thẳng . Lấy các điểm E trên đoạn thẳng AD, F trên đoạn thẳng BC sao cho AE = BF. Chứng minh rằng ba điểm E, O, F thẳng hàng.

	MÔN: VẬT LÝ

I. LÝ THUYẾT:
1. Mắt nhìn thấy một vật khi nào? Thế nào là nguồn sáng, vật sáng? Cho ví dụ.
2. Phát biểu định luật truyền thẳng ánh sáng.
3. Phát biểu định luật phản xạ ánh sáng.
4. Nêu tính chất ảnh tạo bởi gương phẳng, gương cầu lồi, gương phẳng. Một vật đặt trước ba loại gương đó và cách gương một khoảng bằng nhau. So sánh ảnh ảo tạo bởi ba loại gương đó.
5. Nêu đặc điểm chung của nguồn âm. Lấy ví dụ về nguồn âm
6. Tần số dao động là gì? Nêu kí hiệu, đơn vị của tần số. Âm phát ra càng cao (thấp) khi nào?
7. Biên độ dao động là gì? Âm phát ra càng to (nhỏ) khi nào? 
8. Âm truyền được trong những môi trường nào? Không truyền được trong môi trường nào? So sánh vận tốc truyền âm trong môi trường chất rắn, chất lỏng, chất khí.
II.BÀI TẬP: Các dạng sau
1. Bài tập trắc nghiệm: Xem các bài trong SBT.
2. Bài tập giải thích phần âm học như bài 11.9; 13.2, 13.3; 14.3, 14.12; C2/40; C5/41 SGK
3. Bài tập về định luật phản xạ như bài 4.1; 4.3 SBT
4. Bài tập về gương phẳng như bài 5.2, 5.3, 5.4 SBT.
5. Bài tập sử dụng công thức v = s/t. Dạng bài 13.4, 14.9 SBT; C7/42 SGK


	MÔN: SINH HỌC
Phần I. Trắc nghiệm:
Ôn tập từ bài 1: Thế giới động vật đa dạng và phong phú đến bài 28 Thực hành: Xem băng hình về tập tính của sâu bọ.( Trừ các phần, các bài giảm tải).
Phần II. Tự luận:
Câu 1: Trình bày cấu tạo ngoài của tôm sông, nhện, châu chấu thích nghi với đời sống.
Câu 2: Nêu vai trò của một số đại diện lớp Giáp xác, lớp Hình nhện, lớp Sâu bọ.
Câu 3: Trình bày các biện pháp phòng bệnh kiết lị và bệnh sốt rét.
Câu 4: a, Cấu tạo của sán lá gan thích nghi với đời sống kí sinh như thế nào?
   b, Vì sao trâu bò nước ta hay bị mắc bệnh sán lá gan?
Câu 5: Vai trò thực tiễn của giun đốt thường gặp ở địa phương.
Câu 6: Chú thích hình vẽ 20.1, 20.4, 20.5.

	MÔN: TIN HỌC

1) Cấu trúc đề kiểm tra:
· Hình thức đề: Trắc nghiệm (20 câu) và tự luận.
· Thời gian làm bài: 45 phút.
2) Câu hỏi ôn tập: Các dạng câu hỏi sau:

A – PHẦN TRẮC NGHIỆM:
1: Trong các câu sau đây, câu nào là phần mềm bảng tính?
A. Window		B. Microsoft Word		C. Microsoft Excel		D. Tất cả sai
2: Miền làm việc chính của bảng tính là
A. Thanh công thức, hộp tên		C. Tập hợp các ô bảng tính theo chiều ngang	
B. Gồm các cột và các hàng		D. Tập hợp các ô bảng tính theo chiều dọc
3: Muốn lưu bảng tính với tên khác, em thực hiện:
A. Chọn File, Save gõ lại tên khác	B. Chọn File, Save As và gõ lại tên khác
C. Câu a và b đúng			D. Câu a và b sai
4: Công thức = B1 + C3 được đặt trong ô C4. Nếu ta sao chép công thức này sang ô D4 thì công thức trong ô D4 sẽ là:
A. = C2+ C3	B. = C1+ D3	C. = D3 + C4		D. Tất cả đều sai
5: Trên bảng tính, khi muốn di chuyển để thay đổi ô được kích hoạt em phải
A. Dùng các phím mũi tên để di chuyển		B. Sử dụng chuột để di chuyển
C. Dùng phím Backspace để di chuyển		D. Câu a, b đúng
6: Khi mở một bảng tính mới em thường thấy có
A. Một trang tính		B. Hai trang tính	C. Ba trang tính	D. Bốn trang tính
7: Khối ô có thể là
A. Một ô			B. Một dòng		C. Một cột		D. Tất cả đều đúng
8: Khi nhập công thức vào ô, em phải gõ trước công thức dấu:
A. Dấu cộng (+)		B. Dấu ngoặc đơn ( )	C. Dấu bằng (=)	D. Dấu # .
9: Kí hiệu phép nhân và phép chia trong chương trình bảng tính kí hiệu là:
A. Dấu . và :		B. Dấu . và /			C. Dấu * và :	D. Dấu * và /
10: Để kích hoạt ô D200 nằm ngoài phạm vi màn hình (em không nhìn thấy), ngoài cách dùng chuột và các thanh cuốn em có thể:
A. Gõ địa chỉ vào thanh công thức		B. Gõ địa chỉ D200 vào hộp tên
C. Nháy chuột tại nút tên cột D			D. Nháy chuột tại nút tên hàng 200
[image: bai12]11: Cho bảng tính:
a) Kết quả công thức =(A1- B1)*C1 là:
A. 29		B. 18	      C. 27	D. – 37

b) Kết quả công thức =B3/A3 +C3 là
A.11		B. 12       C. 13	D. 14
12: Cho bảng tính

[image: bai13]
a) Để tính cột tổng (H2), ta dùng công thức:
A. =Sum(C2+G2)		B. =Sum(C2:G2)	C. =Sum (C2:G2)         D. sum (C2:G2)
b) Để tính cột trung bình (I2), ta dùng công thức:
A. =Average(C5:H10)                      B. =Average(C5:H10)/5
C. =Average(C2:G2)/5                     D. =Average(C2:G2)
c) Để tìm điểm lớn nhất trong các môn học ta dùng công thức:
A. =Max(C2,G2)		B. Max(C2:G2)	C. = Max(C2:G2)	    D. =Max  (C2:G2)
d) Để tìm điểm nhỏ nhất trong các môn học ta dùng công thức:
A. =Min(C2,G2)		B. Min(C2:G2)	C. = Min (C2:G2)	    D. = Min(C2:G2).
13: Khi viết sai tên hàm trong tính toán, chương trình báo lỗi:
A. #VALUE?		B. #NAME?		C. #DIV/0?			D. #N/A!
14: Nếu trong một ô tính có các kí hiệu #####, điều đó có nghĩa gì?
A. Công thức nhập sai
B. Hàng chứa ô đó có độ cao quá thấp nên không hiển thị hết chữ số
C. Cột chứa ô đó có độ rộng quá hẹp nên không hiển thị hết chữ số
D. Cả 3 câu đều đúng
15: Muốn chọn hai khối không kề nhau ta nhấn cần nhấn giữ phím:
A. Shift 		B. Alt			C. Enter		D. Ctrl
16: Có mấy bước thực hiện nhập công thức vào ô tính?
A. 2 bước		B. 3 bước		C. 4 bước		D. 5 bước
17: Em có thể lưu bảng tính trên máy tính bằng cách xử dụng lệnh :
A. File → Save	B. File → Frint		C. File → Open	D.    File → Close
18: Để chọn đối tượng trên trang tính ,em thực hiện như thế nào ?
Hãy nối cột A với cột B để được phương án đúng .
	A
	B

	1. Chọn một ô
	A. nháy chuột tại nút tên hàng

	2. Chọn một hàng
	B. nháy chuột tại nút tên cột

	3. Chọn một cột
	C. đưa con trỏ chuột tới ô đó và nháy chuột .


19: Để tính tổng giá trị trong các ô C1 và C2, sau đó chia cho giá trị trong ô B3:
A. = (C1 + C2 ) \ B3;		B. (C1 + C2 ) / B3;	
C. = C1 + C2 \ B3;			D. = (C1 + C2 ) / B3.
20: Cách nhập hàm nào sau đây là sai :
A. = MIN(A1,A2,A3);              B. = MIN(A1:A3);
C. = MIN(A1:A2,A3);              D. = MIN (A1:A3).
21: Giả sử cần tính trung bình cộng giá trị của các ô B1,C1và E1 .
Công thức nào trong các công thức sau đây là sai :
A. = SUM(B1,C1,E1)/3;                  B. = AVERAGE (B1,C1,E1);
C. = (B1+C1+E1)/3;                     d . = AVERAGE (B1: C1,E1)
22: Để mở 1 trang tính mới ta phải thực hiện như thế nào ?
A. File → New;		B. File → Exit;	C. File →Open;	D. File → Close;
23: Ô tính A1 có nội dung =AVERAGE(C10:C12). Nếu dùng công thức thì sẽ là:
A. =(C10+C11+C12)/3		C. =C10+C11+C12
B. =(C10:C12)/3			D. =SUM(C10:C12)
24: Ô C3 có công thức =A3+B3. Nếu em sao chép ô C3 sang ô C5 thì ở ô C5 sẽ là:
[image: bai29]A. =A3+B3       B. =A5+B5            C. =C6+D3           D. =B3+A3
25: Địa chỉ của khối ô đang được chọn là:
A. A1,C5	B. A1;C5		C. A2.C5	D. A1:C5
26: Để xóa hàng hay cột ta dùng lệnh:
A. Delete			B. Edit → Delete
C. File → Open		D. File → Close
[image: bai30]27: Cho bảng tính:
a)  Kết quả công thức =A1-B1+C1 là
A. -8		B. 8		C. 6		D. -6
b) Kết quả công thức =A3*B3-C3 là
A. 79		B. 70		C. 69		D. 68
28: Để sao chép dữ liệu trong ô hoặc khối ô ta dùng lệnh :
A. Cut, Paste		B. File, save		C. Copy, Paste		D. Edit, delete
29: Phần mềm Typing Test dùng để:
A. Luyện gõ phím nhanh bằng 10 ngón tay		B. Học địa lý thế giới
C. Học toán học						D. Học vẽ hình hình học động
30: Để chèn thêm hàng ta dùng lệnh:
A. Insert / Rows	B. Insert / Columns	C. Table / Columns       D. Table / Rows

B – PHẦN TỰ LUẬN:
1. Chương trình bảng tính là gì?
2. Nêu các bước nhập công thức vào ô tính? Từ đâu có thể biết một ô chứa công thức hay chứa giá trị cụ thể? Lợi ích của việc sử dụng địa chỉ trong công thức.
3. Trên trang tính:
a) Hãy nêu thao tác điều chỉnh tăng độ rộng của cột B
b) Để điều chỉnh độ rộng cột vừa khít với dữ liệu có trong ô C5 ta cần làm thế nào?
4. Hãy nêu các bước thực hiện thao tác sao chép dữ liệu, di chuyển dữ liệu.
5. Giả sử khối cần sao chép là A3:B5, khối nhận dữ liệu sao chép là ô B6:C8. Để sao chép bằng cặp lệnh Copy – Paste và kết thúc việc sao chép, thao tác cần thực hiện như thế nào?
6. Giả sử khối cần di chuyển là A2:B4, khối nhận dữ liệu di chuyển là ô A6:B8. Để di chuyển bằng cặp lệnh Cut – Paste và kết thúc việc di chuyển, thao tác cần thực hiện như thế nào?
[image: tin]7. Cho dữ liệu như sau, em hãy:
 a) Lập công thức để tính tổng điểm của mỗi bạn?
b) Lập công thức để tính điểm trung bình của mỗi bạn?
c) Lập công thức để tìm điểm cao nhất cho mỗi môn học?
d) Lập công thức để tìm điểm thấp nhất cho mỗi môn học?


	
MÔN: NGỮ VĂN

Ôn tập kiến thức đã học từ tuần 1 đến tuần 15 (SGK Ngữ văn 7 tập I)
A. KIẾN THỨC TRỌNG TÂM
Phần I. Văn bản
1. Văn bản nhật dụng: Cổng trường mở ra, Cuộc chia tay của những con búp bê.
2. Ca dao: Những câu hát về tình cảm gia đình, Những câu hát về tình yêu quê hương, đất nước, con người.
3. Thơ trung đại: Sông núi nước Nam, Bánh trôi nước, Qua Đèo Ngang, Bạn đến chơi nhà.
4. Thơ Đường:  Tĩnh dạ tứ, Hồi hương ngẫu thư.
5. Thơ hiện đại: Cảnh khuya, Rằm tháng giêng, Tiếng gà trưa.
* Yêu cầu:
- Nắm được tác giả, tác phẩm, thể loại, hoàn cảnh sáng tác, phương thức biểu đạt, tóm tắt truyện, bố cục, thuộc thơ, mạch cảm xúc.
- Nắm được nội dung, nghệ thuật, biết khai thác tín hiệu nghệ thuật trong văn bản để làm nổi bật nội dung.
Phần II. Tiếng Việt
1. Từ ghép, từ láy, đại từ, từ Hán Việt, quan hệ từ, từ đồng nghĩa, từ trái nghĩa, từ đồng âm.
2. Thành ngữ.
3. Điệp ngữ.
* Yêu cầu:
- Nhận diện được đơn vị kiến thức tiếng Việt cơ bản trong văn bản.
- Nêu vai trò, tác dụng của các đơn vị kiến thức trong văn bản.
- Vận dụng kiến thức trong thực hành nói và viết.
Phần III: Tập làm văn: Văn biểu cảm về tác phẩm văn học.
* Yêu cầu: 
- Nắm vững đặc điểm thể loại văn biểu cảm về tác phẩm văn học.
- Lập được dàn ý và viết bài văn biểu cảm hoàn chỉnh.
(Lưu ý: GV ra các dạng bài tập vận dụng kiến thức đã học vào việc giải quyết các vấn đề thực tiễn.)
B. MỘT SỐ DẠNG BÀI TẬP
Bài tập 1: Hãy viết một câu ca dao nói về tình cảm sâu nặng và công lao to lớn của cha mẹ đối với con cái. Qua đó em nêu suy nghĩ về vai trò của gia đình đối với mỗi con người.
Bài tập 2: 
a. Chép chính xác bản phiên âm bài thơ “Rằm tháng giêng” của Hồ Chí Minh. Cho biết phương thức biểu đạt và thể thơ.
b. Xác định những biện pháp nghệ thuật được sử dụng trong hai câu thơ đầu bài thơ “Rằm tháng giêng” và cho biết tác dụng.
Bài tập 3: 
a. Chép chính xác bài thơ “Cảnh khuya” của Hồ Chí Minh. Cho biết hoàn cảnh ra đời của bài thơ.
b. Xác định những biện pháp nghệ thuật được sử dụng trong hai câu thơ đầu bài thơ “Cảnh khuya” và cho biết tác dụng.
c. Qua bài thơ “Cảnh khuya”, em hiểu thêm điều gì về con người Bác. Từ đó, em thấy cần làm gì để học tập và làm theo tư tưởng, đạo đức, phong cách Hồ Chí Minh.
Bài tập 4: Cho câu thơ “Trên đường hành quân xa”
a. Hãy chép tiếp 6 câu thơ để hoàn chỉnh khổ thơ đầu bài thơ “Tiếng gà trưa” của Xuân Quỳnh.
b. Chỉ ra các biện pháp nghệ thuật được sử dụng trong đoạn thơ vừa chép và nêu tác dụng.
c. Qua bài thơ em có nhận xét gì về người bà và tình cảm bà cháu? Từ đó, theo em cần phải làm gì để bày tỏ lòng biết ơn đối với ông bà, cha mẹ.
Bài tập 5: Chỉ ra lỗi sử dụng quan hệ từ trong các câu văn sau và chữa lại cho đúng:
a. Dưới ngòi bút của mình, Nguyễn Trãi đã dựng lên cảnh Côn Sơn thật là nên thơ.
b. Qua câu ca dao “Công cha như núi Thái Sơn, Nghĩa mẹ như nước trong nguồn chảy ra” cho ta thấy công lao to lớn của cha mẹ đối với con cái.
c. Chúng ta phải sống cho thể nào để chan hòa với mọi người.
d. Đừng nên nhìn hình thức đánh giá kẻ khác.
Bài tập 6: Giải thích nghĩa các thành ngữ sau đây và đặt câu có sử dụng thành ngữ đó:
a. Một nắng hai sương
b. Lên thác xuống ghềnh 
c. Con Rồng, cháu Tiên
d. Ếch ngồi đáy giếng
Bài tập 7: Biểu cảm về bài thơ “Cảnh khuya” của Hồ Chí Minh.
Bài tập 8: Biểu cảm về bài thơ “Rằm tháng giêng” của Hồ Chí Minh.
Bài tập 9: Biểu cảm về tình bà cháu trong bài thơ “Tiếng gà trưa” của Xuân Quỳnh.
* Chú ý: 
- GV cho HS ôn tập dựa vào các tiết ôn tập theo phân phối chương trình, có thể kết hợp với các tiết bổ trợ.
- Tích hợp giữa Văn bản, Tiếng Việt, Tập làm văn.
- Căn cứ vào đối tượng HS từng lớp, các đồng chí GV có kế hoạch hướng dẫn HS ôn tập cụ thể.


	

MÔN: LỊCH SỬ

I. Nội dung ôn tập.
Học sinh ôn tập những kiến thức Lịch sử đã học từ tuần 1 đến tuần 14, trọng tâm là những bài học sau:
- Sự hình thành và phát triển của xã hội phong kiến ở châu Âu.
- Những nét chung về xã hội phong kiến.
- Nước Đại Việt thời Lý (thế kỉ XI – XII)
- Nước Đại Việt thời Trần (thế kỉ XIII – XIV).
II. Một số dạng câu hỏi và bài tập.
Câu 1/ Xã hội phong kiến châu Âu được hình thành như thế nào ?
Câu 2/ Em hiểu thế nào là lãnh địa phong kiến? Nêu đặc trưng và đặc điểm trong lãnh địa?
Câu 3/ Kể tên các cuộc phát kiến địa lý?
Câu 4/ So sánh xã hội phong kiến ở Phương Đông và phương Tây?
Câu 5/ Tóm tắt cuộc kháng chiến chống Tống của Lê Hoàn năm 981?
Câu 6/ Sự thành lập nhà Lý?
Câu 7/ Nêu chính sách đối nội, đối ngoại thời Lý?
Câu 8/ Nhà Trần thành lập trong hoàn cảnh nào?
Câu 9/ So sánh luật pháp và quân đội thời tiền Lê, Lý và Trần?
Câu 10/ Nhà Trần củng cố chế độ phong kiến tập quyền?
Câu 11/ Nêu diễn biến, kết quả của cuộc kháng chiến chống Tống trên phòng tuyến Như Nguyệt?
Câu 12/ Nêu nguyên nhân thắng lợi, ý nghĩa lịch sử cuộc kháng chiến chống Tống của Lý Thường Kiệt?
Câu 13/ Em hãy trình bày công lao của Ngô Quyền, Đinh Bộ Lĩnh, Lê Hoàn đối với nước ta? (Tại sao nói Ngô Quyền là người có công dựng nền độc lập tự chủ, còn Đinh Bộ Lĩnh là người thống nhất đất nước?)

III. Gợi ý trả lời:
1/ Phần lịch sử thế giới
Câu 1/ Xã hội phong kiến châu Âu được hình thành như thế nào ?
- Lãnh chúa phong kiến: là các tướng lĩnh và quý tộc có nhiều ruộng đất và tước vị, có quyền thế và rất giàu có.
- Nông nô: là những nô lệ được giải phóng và nông dân, không có ruộng đất, làm thuê, phụ thuộc vào lãnh chúa.
- Xuất hiện 2 tầng lớp mới -> Xã hội phong kiến ở châu Âu đã được hình thành.
Câu 2/ Em hiểu thế nào là lãnh địa phong kiến? Nêu đặc trưng và đặc điểm trong lãnh địa?
- Lãnh địa phong kiến là những vùng đất rộng lớn mà các nhà quý tộc chiếm đoạt được biến thành của riêng mình.
- Đặc trưng cơ bản của lãnh địa: là đơn vị kinh tế, chính trị độc lập mang tính tự cung, tự cấp, đóng kín của một lãnh địa.
- Đặc điểm trong lãnh địa :
+ Kinh tế chủ yếu là nông nghiệp (khép kín, tự cấp tự túc)
+ Cư dân: Lãnh chúa và nông nô (Nông nô phụ thuộc hoàn toàn lãnh chúa)
Câu 3/ Kể tên các cuộc phát kiến địa lý?
- Va-xcô đơ Ga-ma
- Đi-a-xơ
- Ma-gien-lan
- Cô –lôm-bô





Câu 4/ So sánh xã hội phong kiến ở Phương Đông và phương Tây?
	 
	Phương Đông
	Phương Tây

	Quá trình hình thành phát triển
	- Ra đời sớm kết thúc muộn (từ thế kỷ thứ III TCN đến giữa thế kỷ XIX)
- Phát triển chậm.
-> bị chủ nghĩa tư bản xâm lược.
	- Ra đời muộn kết thúc sớm (từ thế kỷ thứ V đến thế kỷ thứ XVI).
 
- Phát triển nhanh.
-> chủ nghĩa tư bản hình thành.

	Kinh tế
	- Nông nghiệp bó hẹp, đóng kín trong công xã nông thôn.
- Nông nghiệp kết hợp với chăn nuôi và 1 số nghề thủ công.
	- Nông nghiệp bó hẹp, đóng kín trong lãnh địa phong kiến.
- Nông nghiệp kết hợp với công thương nghiệp.

	Xã hội
	- Địa chủ.
- Nông dân lĩnh canh.
	- Lãnh chúa phong kiến
- Nông nô.

	Phương thức bóc lột
	Địa tô

	Thể chế nhà nước
	Quân chủ chuyên chế.
	Quân chủ phân quyền.


II. Phần lịch sử Việt Nam
Câu 5/ Tóm tắt cuộc kháng chiến chống Tống của Lê Hoàn năm 981?
A. Hoàn cảnh lịch sử:
- Cuối năm 979 nhà Đinh rối loạn ® quân Tống xâm lược.
B. Diễn biến:
- Đầu năm 981, quân Tống tiến theo 2 đường: thuỷ và bộ do Hầu Nhân Bảo chỉ huy.
- Lê Hoàn trực tiếp tổ chức và lãnh đạo cuộc kháng chiến.
- Ông cho quân đóng cọc ở cửa sông Bạch Đằng để chặn quân thuỷ của địch. Nhiều trận chiến đấu diễn ra ác liệt. Cuối cùng quân thủy bị đánh lui.
-Trên bộ, quân ta chặn đánh quân Tống quyết liệt, không kết hợp được với quân thủy nên quân Tống bị tổn thất nặng nề, buộc phải rút quân về nước.
C. Kết quả, ý nghĩa:
- Cuộc kháng chiến thắng lợi.
D. Ý nghĩa
+ Chiến thắng biểu thị ý chí quyết tâm chống ngoại xâm của quân dân ta.
+ Chứng tỏ bước phát triển mới của đất nước và khả năng bảo vệ độc lập dân tộc của Đại Cồ Việt.
Câu 6/ Sự thành lập nhà Lý?
- Năm 1005, Lê Hoàn mất, Lê Long Đĩnh nối ngôi và năm 1009 thì qua đời.
- Triều thần chán ghét nhà Lê đã tôn Lý Công Uẩn lên ngôi vua. Nhà Lý được thành lập.
- 1010, Lý Công Uẩn đặt niên hiệu là Thuận Thiên và dời đô ra Đại La, đổi tên thành là Thăng Long.
- Năm 1054, nhà Lý đổi tên nước là Đại Việt.
- Xây dựng bộ máy chính quyền từ trung ương đến địa phương.
+ Vua đứng đầu nắm giữ mọi quyền hành, theo chế độ cha truyền con nối.
+ Giúp việc cho vua là các đại thần, các quan văn võ.
+ Ở địa phương: cả nước chia làm 24 lộ, phủ; dưới lộ, phủ là huyện, hương và xã.
Câu 7/ Nêu chính sách đối nội, đối ngoại thời Lý?
- Đối nội:
+ Củng cố khối đoàn kết dân tộc: gả công chúa, ban tước cho các tù trưởng miền núi
+ Kiên quyết trấn áp những kẻ muốn tách khỏi Đại Việt.
- Đối ngoại: thực hiện chính sách ngoại giao mềm dẻo:
+ Đặt quan hệ ngoại giao bình thường với nhà Tống, Cham-pa.
+ Kiên quyết dẹp tan cuộc tấn công của Cham-pa.
=> tác dụng: củng cố quốc gia thống nhất, tạo điều kiện bảo vệ và xây dựng đất nước lâu dài.
Câu 8/ Nhà Trần thành lập trong hoàn cảnh nào?
- Từ cuối thế kỉ XII, nhà Lý suy yếu, chính quyền không chăm lo đời sống nhân dân, quan lại ăn chơi sa đoạ.
- Kinh tế khủng hoảng, mất mùa, dân li tán.
- Các thế lực phong kiến địa phương chém giết lẫn nhau, chống lại triều đình.
- Nhà Lý buộc phải dựa vào thế lực họ Trần để chống lại các lực lượng nổi loạn.
- Tháng 12 năm Ất Dậu (đầu năm 1226), Lý Chiêu Hoàng nhường ngôi cho chồng là Trần Cảnh. Nhà Trần được thành lập.

Câu 9/ So sánh luật pháp và quân đội thời tiền Lê, Lý và Trần?
	 
	Tiền Lê
	Lý
	Trần

	Luật pháp
	 
	- 1042, ban hành bộ luật Hình thư.
- Nội dung:
+ Bảo vệ nhà vua và cung điện.
+ Bảo vệ của công và tài sản của nhân dân.
+ Bảo vệ sản xuất nông nghiệp.
 
	- 1230, ban hành bộ Quốc triều hình luật.
- Nội dung:
+ Giống như bộ luật thời Lý.
+ Được bổ sung thêm: Pháp luật xác nhận và bảo vệ quyền tư hữu tài sản, quy định cụ thể việc mua bán ruộng đất
- Cơ quan pháp luật: Thẩm hình viện là cơ quan chuyên xét xử kiện cáo.

	Quân đội
	- Gồm 10 đạo chia thành 2 bộ phận:
+ Cấm quân.
+ Quân địa phương.
- Tổ chức theo chế độ “ngụ binh ư nông” (gửi binh ở nhà nông).
 
 
 
 
 
 
 
	- Gồm 2 bộ phận:
+ Cấm quân.
+ Quân địa phương
- Tổ chức theo chế độ “ngụ binh ư nông”.
+ Quân đội thời Lý bao gồm quân bộ và quân thuỷ.
+ Vũ khí có giáo mác, đao kiếm, cung nỏ, máy bắn đá.
=> mạnh, đủ sức đương đầu với kẻ thù
 
	- Quân đội gồm 2 bộ phận chính:
+ Cấm quân (đạo quân bảo vệ kinh thành, triều đình và nhà vua)
+ Quân ở các lộ.
- Ngoài ra, có Hương binh ở làng xã và Quân của các vương hầu.
- Quân đội được tuyển theo chính sách "ngụ binh ư nông"; và chủ trương "quân lính cốt tinh nhuệ, không cốt đông"; xây dựng tinh thần đoàn kết.
- Học tập binh pháp và luyện tập võ nghệ.
- Bố trí tướng giỏi, quân đông ở vùng hiểm yếu, nhất là biên giới phía Bắc.


* Việc xây dựng quân đội nhà Trần có gì khác và giống so với thời Lý?
->Giống:
+ Quân đội gồm hai bộ phận.
+ Được tuyển dụng theo chính sách "ngụ binh ư nông".
- Khác: nhà Trần:
+ Cấm quân: Tuyển những người khoẻ mạnh ở quê hương nhà Trần.
+ Quân đội theo chủ trương: "Quân lính cốt tinh nhuệ, không cốt đông".
Câu 10/ Nhà Trần củng cố chế độ phong kiến tập quyền?
- Được tổ chức theo chế độ quân chủ trung ương tập quyền, gồm 3 cấp: triều đình, các đơn vị hành chính trung gian từ lộ, phủ, huyện, châu và cấp hành chính cơ sở là xã.
- Thực hiện chế độ Thái thượng hoàng.
- Các chức đại thần văn, võ phần lớn do họ Trần nắm giữ.
- Đặt thêm một số cơ quan như Quốc sử viện, Thái y viện,Tôn nhân phủ, và 1 số chức quan như Hà đê sứ, Khuyến nông sứ, Đồn điền sứ...
- Cả nước chia lại thành 12 lộ, dưới lộ là phủ, châu, huyện và dưới cùng là xã.
- Các quý tộc họ Trần được phong vương hầu và ban thái ấp.
Câu 11/ Nêu diễn biến, kết quả của cuộc kháng chiến chống Tống trên phòng tuyến Như Nguyệt?
*Diễn biến:
- Chờ mãi không thấy quân tiếp viện, Quách Quỳ cho quân bắc cầu phao đánh sang phòng tuyến của ta nhưng đều thất bại.
- Quân Tống rơi vào thế khó khăn, đúng lúc đó Lý Thường Kiệt cho đọc bài thơ thần khiến chúng càng hoang mang tuyệt vọng.
- Cuối xuân năm 1077, quân ta phản công, quân Tống thua to, lâm vào tình thế khó khăn, tuyệt vọng.
- Lý Thường Kiệt chủ động kết thúc chiến tranh bằng đề nghị "giảng hoà", quân Tống chấp thuận ngay, vội rút quân về nước.
*Kết quả:
- Cuộc kháng chiến chống Tống thắng lợi.
Câu 12/ Nêu nguyên nhân thắng lợi, ý nghĩa lịch sử cuộc kháng chiến chống Tống của Lý Thường Kiệt?
*Nguyên nhân:
- Do sự chỉ huy tài tình của Lý Thường Kiệt.
- Do tinh thần đoàn kết của toàn dân ta
- Do có sự chuẩn bị chu đáo: bố trí trận địa mai phục ở sông Như Nguyệt.
*Ý nghĩa:
- Là trận đánh tuyệt vời trong lịch sử dân tộc.
- Nhà Tống từ bỏ mộng xâm lược Đại Việt.
- Nền độc lập, tự chủ của Đại Việt được bảo vệ.
Câu 13/ Em hãy trình bày công lao của Ngô Quyền, Đinh Bộ Lĩnh, Lê Hoàn đối với nước ta? (Tại sao nói Ngô Quyền là người có công dựng nền độc lập tự chủ, còn Đinh Bộ Lĩnh là người thống nhất đất nước?)
- Ngô Quyền:
+ Người tổ chức và lãnh đạo quân dân ta làm nên chiến thắng trên sông Bạch Đằng năm 938. Đó là một chiến thắng vĩ đại của dân tộc ta, kết thúc ách thống trị hơn một nghìn năm của phong kiến phương Bắc đối với nước ta, mở ra kỉ nguyên độc lập, tự chủ của Tổ quốc.
+ Ngô Quyền xưng vương, đặt nền móng cho một quốc gia độc lập đã khẳng định đất nước ta có giang sơn, bờ cõi riêng, do người Việt làm chủ và quyết định vận mệnh của mình.
- Đinh Bộ Lĩnh:
+ Là người có công lớn trong việc dẹp "Loạn12 sứ quân". Vì trước nguy cơ ngoại xâm mới (mưu đồ xâm lược nước ta của nhà Tống) đòi hỏi phải nhanh chóng thống nhất lực lượng để đối phó, đó cũng là nguyện vọng của nhân dân ta thời bấy giờ. Đinh Bộ Lĩnh đã hoàn thành sứ mệnh lịch sử đó.
+ Việc đặt tên nước, chọn kinh đô và không dùng niên hiệu của hoàng đế Trung Quốc đã khẳng định đất nước ta là "nước Việt lớn", nhà Đinh cóý thức xây dựng nền độc lập, tự chủ.
- Lê Hoàn:
+ Người tổ chức và lãnh đạo cuộc kháng chiến chống Tống năm 981 giành thắng lợi, có ý nghĩa lịch sử to lớn.


	MÔN: ĐỊA LÝ

I. Kiến thức trọng tâm
- Dân số 
- Sự phân bố dân cư. Các chủng tộc trên thế giới
- Quần cư. Đô thị hóa
- Đới nóng. Môi trường xích đạo ẩm
- Môi trường nhiệt đới.
- Môi trường nhiệt đới gió mùa.
- Dân số và sức ép tài nguyên môi trường tới dân số ở đới nóng.
- Môi trường đới ôn hòa, môi trường đới lạnh, môi trường vùng núi
- Thiên nhiên châu Phi
II. Bài tập vận dụng
Câu 1: Trình bày đặc điểm khí hậu và các môi trường tự nhiên ở châu Phi ?
Câu 2: Giải thích vì sao các hoang mạc ở châu Phi lại lan ra sát biển?
Câu 3: Trình bày thực trạng ngành công nghiệp châu Phi?Tại sao công nghiệp châu Phi còn chậm phát triển?
Câu 4: Phân biệt sự khácnhau giữa lục địa và châu lục? Kể tên sáu lục địa và sáu châu lục trên thế giới?
Câu 5: Cho bảng số liệu dân số và tỉ lệ dân thành thị ở một số quốc gia châu Phi năm 2000 và 2009
	Quốc gia
	Dân số (triệu người)
	Tỉ lệ dân thành thị (%)

	
	Năm 2000
	Năm 2009
	Năm 2000
	Năm 2009

	An - giê - ri
	31,0
	35,4
	49,0
	63,0

	Ai - Cập
	69,8
	78,6
	43,0
	43,0

	Ni - giê - ri – a
	126,6
	152,6
	36,0
	47,0

	Xô - ma - li
	7,5
	9,1
	18,0
	37,0

	Kê - ni - a
	29,8
	39,1
	20,0
	19,0


- Nhận xét và giải thích về dân số và tỉ lệ dân thành thị ở một số quốc gia châu Phi?



	MÔN: GDCD

I. NỘI DUNG ÔN TẬP. Ôn các bài từ tuần 1 đến hết tuần 14. Trong đó, trọng tâm kiến thức:
- Bài 8: Khoan dung
- Bài 9: Xây dựng gia đình văn hóa
- Bài 10: Giữ gìn và phát huy truyền thống tốt đẹp của gia đình dòng họ.
*Lưu ý: Vận dụng các kiển thức đã học vào giải quyết các tình huống trong thực tế.

II. CÂU HỎI ÔN TẬP.
Câu 1 : Thế nào là khoan dung? Em hãy nêu hai biểu hiện của lòng khoan dung trong cuộc sống?
Câu 2: Vì sao chúng ta cần phải sống khoan dung với mọi người? Em hãy nêu cách rèn luyện của bản thân để trở thành người có lòng khoan dung?
Câu 3: Thế nào là gia đình văn hóa? Vì sao chúng ta cần phải xây dựng gia đình văn hóa?
Câu 4: Là thành viên trong gia đình, em cần có trách nhiệm gì để góp phần xây dựng gia đình mình trở thành gia đình văn hóa?
Câu 5: Truyền thống gia đình, dòng họ có ảnh hưởng đối với mỗi con người như thế nào? Em tự hào về điều gì về gia đình, dòng họ của mình?
Câu 6 : Giữ gìn và phát huy truyền thống tốt đẹp của gia đình, dòng họ có ý nghĩa như thế nào đối với mỗi con người?

III. BÀI TẬP. Học sinh làm các bài tập trong SGK vận dụng kiến thức lý thuyết vào giải quyết các vấn đề trong cuộc sống.
Bài 8 : Khoan dung
· Bài a, c, d, đ trong SGK trang 26.
Bài 9 : Xây dựng gia đình văn hóa
· Bài b, c, d, đ, e trong SGK trang 29.
Câu 1 : Thế nào là khoan dung? Em hãy nêu hai biểu hiện của lòng khoan dung trong cuộc sống
*  Khoan dung có nghĩa là rộng lòng tha thứ. Người có lòng khoan dung luôn luôn tôn trọngvà thông cảm với người khác, biết tha thứ cho người khác khi họ hối hận và sửa chữa lỗi lầm.
* Biểu hiện của lòng khoan dung :
- Biết lắng nghe để hiểu người khác,biết tha thứ cho người khác
- Không chấp nhặt, không thô bạo
- Không định kiến, không hẹp hòi khi nhận xét người khác
- Luôn tôn trọng và chấp nhận người khác...
Câu 2: Vì sao chúng ta cần phải sống khoan dung với mọi người? Em hãy nêu cách rèn luyện của bản thân để trở thành người có lòng khoan dung?
* Chúng ta cần phải sống khoan dung với mọi người vì :
- Khoan dung là một đức tính quý báu của con người. Người có lòng khoan dung luôn được mọi người yêu mến, tin cậy. Nhờ có lòng khoan dung, cuộc sống và quan hệ giữa mọi người trở nên lành mạnh, thân ái, dễ chịu.
* Cách rèn luyện:
- Chúng ta hãy sống cởi mở, gần gũi với mọi người và cư xử chân thành, rộng lượng, biết tôn trọng và chấp nhận cá tính, sở thích, thói quen của người khác.
- Phải luôn có thái độ vui vẻ, cởi mở, cùng học, cùng chơi với các bạn, không phân biệt nam, nữ, dân tộc, học giỏi hay học kém, giàu hay nghèo
- Chia sẻ vui buồn cùng bạn bè và những người xung quanh....
Câu 3 : Thế nào là gia đình văn hóa ? Vì sao chúng ta cần phải xây dựng gia đình văn hóa?
* Gia đình văn hóa là: gia đình hòa thuận, hạnh phúc, tiến bộ, thực hiện kế hoạch hóa gia đình, đoàn kết với xóm giềng và làm tốt nghĩa vụ công dân.
* Ý nghĩa :
· Gia đình là tổ ấm nuôi dưỡng, giáo dục mỗi con người
· Gia đình bình yên thì xã hội mới ổn định
· Xây dựng gia đình văn hóa là góp phần xây dựng xã hội văn minh tiếnbộ…
Câu 4: Là thành viên trong gia đình, em cần có trách nhiệm gì để góp phần xây dựng gia đình mình trở thành gia đình văn hóa?
-Họ sinh tự liên hệ về gia đình của mình.

Câu 5. Truyền thống gia đình, dòng họ có ảnh hưởng rất lớn đối với mỗi con người chúng ta.
- Truyền thống là sức mạnh thúc đẩy các thế hệ sau không ngừng vươn lên để tiếp nối, làm rạng rỡ truyền thống đó, phát huy truyền thống tốt đẹp của gia đình, dòng họ là thể hiện lòng biết ơn những người đi trước và sống biết ơn những gì được hưởng.
- Học sinh tự liên hệ về truyền thống văn hóa gia đình mình.
Câu 6: Giữ gìn và phát huy truyền thống tốt đẹp của gia đình, dòng họ giúp ta có thêm kinh nghiệm, sức mạnh trong cuộc sống, làm phong phú truyền thống, bản sắc dân tộc Việt Nam.
Học sinh phải trân trọng, tự hào và tiếp nối truyền thống, sống trong sạch, lươngthiện và không xem thường và làm tổn hại đến các thanh danh của gia đình, dòng họ.
III. BÀI TẬP.
Bài 8 :  Khoan dung :
a, Việc làm thể hiện lòng khoan dung.
-  Biết tha thứ cho lỗi nhỏ của bạn.
- Nhường nhịn em nhỏ.
- Chăm chú lắng nghe để hiểu mọi người….
c, Lan không độ lượng, khoan dung với việc làm vô ý của Hằng	
Bài 9 :  Xây dựng gia đình văn hóa
 BT d:
- Đồng ý với ý kiến: 5.
- Không đồng ý: 1,2,3,4,6,7.
 BT g:
+ Thực hiện sinh đẻ có kế hoạch.
+ Nuôi con khoa học ngoan ngoãn, học giỏi.
+ LĐ xây dựng KT gia đình ổn định.
+ Thực hiện bảo vệ môi trường.
+ Hoạt động từ thiện.
+ Tránh xa và bài trừ tệ nạn xã hội.
Phần bài tập tình huống: Tùy vào tình huống cụ thể, cách diễn đạt khác nhau, học sinh cần đảm bảo những ý sau:
* Nhận xét:
- Hành vi đó đúng hay sai, thuộc phẩm chất đạo đức nào.
- Giải thích rõ vì sao?
*Cách giải quyết:
- Phân tích, giảng giải đưa ra lời khuyên căn cứ vào tình huống
- Đồng tình, phản đối, đưa ra hướng giải quyết cụ thể
- Rút ra bài học cho bản thân mình trong ứng xử và việc làm.


	MÔN: CÔNG NGHỆ

A/ HỆ THỐNG KIẾN THỨC
Học sinh cần nắm được kiến thức về:
1.Cách sử dụng và bảo quản các loại phân bón thông thường
2. Vai trò của giống và cách chọn tạo giống cây trồng
3. Cách sản xuất và bảo quản giống cây trồng
4.Sâu, bệnh hại cây trồng
5. Phòng, trừ sâu, bệnh hại cây trồng.
B/ CÂU HỎI ÔN TẬP
Câu 1: Có những thời kỳ bón phân  nào? Phân loại? Nêu cách bảo quản phân bón?
Câu 2: Giống cây trồng có vai trò như thế nào trong trồng trọt? Nêu tiêu chí của giống cây trồng tốt?
Câu 3: Nêu những điều kiện cần thiết để bảo quản tốt hạt giống?
Câu 4: Nêu tác hại của sâu bệnh? Những dấu hiệu thường gặp khi cây bị sâu, bệnh phá hoại?
Câu 5: Thế nào là biến thái côn trùng? Có mấy kiểu biến thái? 
Câu 6: Nêu những nguyên tắc trong phòng trừ sâu, bệnh hại? Có những biện pháp phòng trừ sâu, bệnh hại nào? (ưu điểm, nhược điểm)
Câu 7: Khi sử dụng thuốc hóa học trừ sâu, bệnh ta cần đảm bảo các yêu cầu gì?


	MÔN: THỂ DỤC

I. MỤC TIÊU:
1. Kiến thức: 
- Kiểm tra đánh giá kết quả tập luyện cho học sinh.
- Nhận xét, đánh giá và xếp loại học sinh.
2. Kỹ năng:
+ HS: thực hiện đúng kĩ thuật phát cầu cao sâu và thực hiện di chuyển bước kép. 
3. Thái độ: HS kiểm tra nghiêm túc, ý thức tổ chức kỷ luật cao, tinh thần giúp đỡ bạn bè và nâng cao thành tích trong học tập và rèn luyện qua các tiết học.
- Giáo dục HS tính kỷ luật cao, tự giác trong tiết kiểm tra.
II. NỘI DUNG KIỂM TRA VÀ ĐÁNH GIÁ XẾP LOẠI
1. Nội dung kiểm tra : TTTC (Cầu lông)
-  Thực hiện kĩ thuật phát cầu cao sâu và di chuyển bước kép chếch phải, chếch trái.
 2.  Đánh giá và xếp loại :
- Điểm Đạt (Đ): 
+ HS thực hiện được đối với Nam 7/10 quả ,với Nữ 5/10 quả đúng kĩ thuật phát cầu cao sâu và di chuyển bước kép chếch phải,chếch trái. 
- Điểm Chưa Đạt (CĐ) :
 + Phát cầu cao sâu dưới 7 quả đối với Nam và dưới 5 quả đối với Nữ, thực hiện sai di chuyển bước kép chếch phải, chếch trái.


	MÔN: ÂM NHẠC

I/  Nội dung  ôn tập:
Học sinh học thuộc lòng  bài hát và tập đọc nhạc
Trình bày một trong những bài sau (Học sinh bốc thăm bài)
1. Hát bài “Chúng em cần hòa bình”.
2. Hát bài “Khúc hát chim sơn ca”.
3. Tập đọc nhạc số 3
4. Tập đọc nhạc số 4

II/  Yêu cầu:
1. Hát đúng lời ca, giai điệu, thể hiện tốt sắc thái, tình cảm
2.  Đọc đúng cao độ, trường độ, gõ đúng phách, thể hiện đúng tính chất  nhịp của bài tập đọc nhạc 


	MÔN: MỸ THUẬT

I. NỘI  DUNG ÔN TẬP
1. Chủ đề trang trí và ứng dụng trong đời sống
- Vẽ trang trí: Tạo họa tiết trang trí
- Vẽ trang trí: Tạo dáng và trang trí lọ hoa
2. Chủ đề vẽ tranh 
- Vẽ tranh: Đề tài tự chọn
II. MỤC ĐÍCH, YÊU CẦU
1. Chủ đề trang trí và ứng dụng trong đời sống
· Học sinh hiểu được đặc điểm, vai trò sử dụng của họa tiết trang trí
· Học sinh biết cách sử dụng họa tiết trang trí vào trong các bài trang trí ứng dụng
· Học sinh biết cách vẽ một bài trang trí đẹp, có bố cục hài hòa, họa tiết sinh động, màu sắc phù hợp.
2. Chủ đề vẽ tranh
· Học sinh chọn được một nội dung đề tài theo ý thích
· Học sinh biết cách vẽ một bức tranh đề tài
· Hoàn thành được một bức tranh đề tài, bố cục hài hòa, hình vẽ sinh động, màu sắc phù hợp
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STT]| Ho tén Toan |Van  |Anh  |Vitly |Tin _ |Téng diém TBC
1 |Ha Phuong Anh 3 4 4 3 7
2 |Hb Mai Anh 5 6 5 5| 8
3 |Lé Phuong Anh 7 7 8 6 9
4 |Nguyén Phan Anh 7 7 8 79
5_|Tran Minh Anh 10 B 9 5] 9
6 |Tran Viét Anh 10 B 9 9 10
7 |Trin L& Ngoc Anh 7 38 6 6| 9
8 |Lé Thi Khanh Chi 7 8 7 8 9
9 |L& Nguyén Ngoc Digp 8 8 7 8 10
10 |Nguyén Tho Diing 8 7 6 79
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